UNIT 16  SPREADSHEET CONCEPTS

Structure

16.0 Objectives
16.1 Introduction
16.2 Starting MS Excel
16.3 Excel Screen Layout
16.4 Excel Menu
16.5 Making Worksheets
  16.5.1 Data Handling & Editing
  16.5.2 Formatting
  16.5.3 Cell Comments
  16.5.4 Naming Cells and Ranges
  16.5.5 Addressing and Its Types
16.6 Organizing Charts and Graphs
16.7 Project Involving Multiple Spreadsheets
  16.7.1 Naming a Worksheet
  16.7.2 Inserting a New Worksheet
  16.7.3 Deleting a Worksheet
  16.7.4 Grouping Worksheets
  16.7.5 Ungrouping Worksheets
  16.7.6 Repositioning of Worksheets in a Workbook
  16.7.7 Hiding Worksheets
  16.7.8 Linking Worksheets
  16.7.9 Protecting the Workbook
  16.7.10 Saving a Worksheet
16.8 Printing a Worksheet
16.9 How to Use Excel Help
16.10 Let Us Sum Up
16.11 Key Words
16.12 Terminal Questions

16.0 OBJECTIVES

After completing this unit, you should be able to:

- understand the basic features of Excel;
- know how to create worksheet and compute data;
- understand the screen display of Excel;
- describe the different icons available in Excel menu;
• make worksheets in Excel;
• learn how to organize charts and graphs; and
• understand how to print the worksheet.

16.1 INTRODUCTION

At homes, we track our own budgets and investments, and at office we have numerical tasks to be performed, which may be related to accounts, taxes, sales or budgeting. Businesses also need graphs and charts for analysis and projections. Further, commerce students who are pursuing their bachelors in Commerce from School of Management Studies, Indira Gandhi National Open University deal with big numbers, formulas and calculations and almost all of us in the present scenario deal with tables, data and calculations in one way or other directly or indirectly. There are many worksheet software packages available to assists us in all these number based functions. Electronic spreadsheets are most common tools to handle such requirements. Spreadsheets are brilliantly conceived ways to organize data by grouping it into rows and columns, they are used to organize, analyze and manipulate all type of data but it provides enhanced functionalities for numerical data. There are quite a few electronic spreadsheet programs available like Microsoft Excel, Open Office Calc or Google spreadsheets which are available on cloud. We will consider MS Excel for our study due to its wide coverage and omnipresent usage in nature. It comes bundled in Microsoft Office which is an office automation tool. Microsoft Excel is one of the powerful spreadsheet tools, which is used by different people in their day-to-day jobs. In this unit, we will discuss the basic functionalities of Microsoft Excel, application software of the Microsoft Office package, used to store, maintain, manage, manipulate and organize the business data used for commercial purpose and running the business smoothly and systematically.

16.2 STARTING MS EXCEL

Microsoft Excel spreadsheet is designed for everyday tasks such as setting up a budget, maintaining an address list, or keeping track of a list of to-do items. Excel is part of Microsoft Office, and comes pre-loaded on your computer. You can start MS Excel by either of the following two ways:

• Click on Start → All Program → Microsoft Office → Microsoft Office Excel
Double click on the MS Excel icon on the desktop (if you have one).

When Excel opens, a new document (called Workbook in Excel) with default name as Book1 is opened. For each additional Workbook you open, the number increases by one. Please note that you can open more than one Workbook at a time. By default each Workbook contains three worksheets. You may increase or decrease the number of worksheets in a Workbook. How we do it, we will learn later.

You may also start Excel by clicking on a Workbook saved on your hard drive. Excel will open automatically and the Workbook will be displayed in the Excel window.

### 16.3 EXCEL SCREEN LAYOUT

When you open Excel from the menu or desktop icon, the screen will look like in Figure 16.2
Let us familiarize ourselves with the key components, mentioned in the excel screen layout shown above in figure 16.2.

**The Microsoft Office Button**

It is the button in the upper-left corner of the Excel Window. When you click on the button, it displays a menu that can be used to create a new Workbook, open an existing Workbook, save a Workbook, print and perform many other tasks.

**The Quick Access Toolbar**

It is present next to the Microsoft Office Button on the top. It provides you access to the commands you frequently use. By default following appear on the Quick Access Toolbar:

- **Save**: To save your file (you may also press keyboard button (Ctrl + S).
- **Undo**: To rollback the action that you last took (Ctrl + Z).
- **Redo**: To reapply the action you rolled back or to repeat an action (Ctrl + Y).

**The Title Bar**

It is next to the Quick Access toolbar at the top. It displays the title of the Workbook on which you are currently working. By default, the first new Workbook is named as Book1. For each additional Workbook you open, the number increases by one. You may save the Workbooks by any legal filename you want.

**Setting Up Your Excel Environment**

Before you begin working on your spreadsheet, you may want to set up your Excel environment and become familiar with a few key tasks such as how to maximize and minimize the Ribbon, configure the Quick Access toolbar, display/ hide the formula bar, change page views etc.

**Minimize and Maximize the Ribbon**

- Right click anywhere in the main menu
- Select **Minimize the Ribbon** in the menu that appears. This will toggle the Ribbon on and off.

![Fig. 16.3: Minimize the Ribbon](image-url)
The check mark beside ‘Minimize the Ribbon’ option indicates the feature is active. You may choose to use this option, if you prefer not to use the Ribbon, but use different menus and keyboard shortcuts.

This menu also has option to **Show Quick Access Toolbar below the Ribbon**, instead of at the top. You can also Customize Quick Access Toolbar using the option available in this menu. Choosing this option displays the window as shown in figure 16.4

**Add Commands to Quick Access Toolbar**
- Click the arrow (customize quick access toolbar) to the right of the Quick Access toolbar.
- Select the command you wish to add from the drop down menu. The command will appear in the Quick Access Toolbar

You can also select **More commands…** from the menu to open the screen as shown in Figure 16.4. Here, you can one by one add commands to the toolbar or remove commands from the toolbar to make specific features easily accessible.

![Fig. 16.4: Customizing Quick Access Toolbar](image)

**Display or Hide the Formula Bar**
- Click the **View** Tab of the Ribbon.
- In the **Show/Hide** group check/ uncheck against formula bar to show/ hide formula bar.

**Expand Formula Bar**

The **Expand/ Collapse formula bar** button is present at the far right end of the formula bar.
Click on the button to expand or collapse the formula bar.

**Customize the Status Bar**
- Right click anywhere on the Status Bar.
- From the menu that appears, select the options that you want to see on the Status Bar. If the option is selected a check mark appears before it. Ensure that View Shortcuts and Zoom Slider options are selected.

**Zoom In and Out**
- Locate the zoom bar in the bottom, right corner.
- Left-click the slider and drag it to the left to zoom out and to the right to zoom in.

You can also use the Zoom group in the View Tab of the Ribbon to set your zoom.

**Change Page Views**
- Locate the Page View options in the bottom, right corner. Click on an option to select it. Different page view options are:
  - **Normal**: This is the default view.
  - **Page Layout**: This view is very helpful from printing point of view. When you select this view, you are able to see the header block, all the margins around the worksheet, the vertical and horizontal rulers and the column and row headings also appear differently. This view shows how exactly the Workbook would look like when you print it.
  - **Page Break**: This view is useful to determine where the page will break when you are trying to print an Excel sheet that spans multiple pages.
You can also set the page view using **Workbook Views** group in the View tab on the Ribbon.

**Customizing the Environment Using Excel Options**

The **Excel Options** menu allows you to customize Excel according to your preferences.

- Click the Microsoft Office Button
- Click on ‘Excel Options’ button located at the bottom of the menu.

![Fig. 16.8: Excel Options Button](image)

When you click on Excel Options button, an extensive menu will open.

Using Excel Options menu, you can personalize your work environment with the mini toolbar, Live preview, color schemes, customize sort and fill sequence, auto correction setting, modify default options for new Workbooks, calculation options, specify options for editing, copying, pasting formulas, calculations and other general setting.

### 16.4 EXCEL MENU

When you open Excel from the menu or desktop icon, the screen will look like in Figure 16.9:

![Fig. 16.9: Excel Menu](image)
The Menu Bar

The menu Bar is the panel at the top portion of the document, right below the Title Bar. To begin with it has following seven tabs:

- **Home**: It has basic commands for creating, formatting and editing the spreadsheets. It has controls for working with the clipboard, fonts, alignment, number, styles, cells and editing.
- **Insert**: It has commands for inserting tables, pictures, shapes, other illustrations, links, charts, header, footer, etc.
- **Page Layout**: The commands here help to set the layout of the spreadsheet, apply a theme to set the overall look, set the margins, orientation, size, backgrounds, etc.
- **Formulas**: It has commands that help you use different formulas and functions.
- **Data**: Has commands to import, query, view data from external sources, sort, filter or manage data.
- **Review**: Has commands to add comments, protect sheet, protect Workbook, share Workbook, etc.
- **View**: Helps to change the display of the worksheet area.

Besides these basic tabs, additional tabs appear from time to time, depending on the context we are working in. These tabs are called contextual tabs. For example, if you select a chart, a Chart Tools contextual tab appears that has commands to help you design and format the chart. These contextual tabs appear in a different color to make them easy to spot.

The commands on each tab are organized into groups. Hence, a group is a collection of logically related command buttons that you can use to manage a Worksheet. Commonly used features are displayed on the Ribbon and additional options can be accessed through the dialog box launcher at the bottom-right corner of each group.

The Formula Bar

The formula bar is divided into three sections:

- **Name Box**: Located on the left most side of the formula bar, it displays the address of the current cell
- **Formula Bar Buttons**: Middle section of the formula bar with indented circle on the left (to increase or decrease the size of the name box) and function wizard (labeled fx) on the right. When you start entering data in the cell, **Cancel** (×) and **Enter** (✓) buttons also appear.
- **Cell Contents**: Right side of the formula bar displays the cell entries.
**The Worksheet Area**

The worksheet area displays all the cells. It is in the cells that you enter, format or edit your data.

**The Status Bar**

The Status bar appears at the very bottom of the Excel window and provides such information as the sum, average, minimum, and maximum value of selected numbers. You can change what displays on the Status bar by right-clicking on the Status bar and selecting the options you want from the Customize Status Bar menu. You click a menu item to select it. You click it again to deselect it. A check mark next to an item means the item is selected.

**Check Your Progress A**

1) **What is title bar?**

2) **How to maximise and minimise the ribbon?**

3) **Which are the three options available on Quick Access Toolbar by default?**

4) **What is the role of page break?**
16.5 MAKING WORKSHEETS

When Excel opens, a new document (called Workbook in Excel) with default name as Book1 is opened. For each additional Workbook you open, the number increases by one i.e. Book1, Book2, and so on. Please note that you can open more than one Workbook at a time. By default each Workbook contains three worksheets. You may increase or decrease the number of worksheets in a Workbook. An Excel Workbook is another word for your Excel file. Here, we will learn how to open a Workbook, create a Workbook from a template and viewing multiple Workbooks at the same time. Further, Excel Worksheets (or spreadsheet) is a collection of cells where you keep and manipulate the data.

When you would like to open a new Workbook then click on the office button and click new, it will open the following window from where you can choose a blank Workbook.

![Create a Workbook (blank)](image)

If needed then you can choose installed templates from your system as well, if they are not available in your system then you can download the templates which can generate Workbooks of your choice.
Fig. 16.11: Create a Workbook (templates)

Saving an excel Workbook as a file needs following steps to be followed:

1) Create a dataset in the Workbook – sheet1
2) Click on the office button, place at top left corner.
3) Choose the Save As option and it will open the following dialog box.
4) Write the file name for the Workbook and choose the location to save.
5) Click the save button.

Fig. 16.12: Save a Workbook

To open an existing excel Workbook saved already at any given location, you have to follow the steps as mentioned below:

1) Click the office button.
2) Choose the file – open option.
3) It will open the following dialog box for you.
4) Select the location from where you have to choose the file.
5) Choose the file to open.
6) Click open file button.

Fig. 16.13: Open a Workbook

Working with Multiple Workbooks
Multiple Workbooks can be opened simultaneously if there is such a need. To see the list of open Workbooks:
- Click on View tab of the Ribbon
- Click on Switch Windows in the Window group. A drop down list of all open Workbooks is displayed.

The current Workbook has a checkmark besides its name. You may select any Workbook from the list to make it current.

To close an excel Workbook you have to follow the steps mentioned below:
1) Click the office button.
2) Select the Close option.

Fig. 16.14: Close a Workbook
16.5.1 Data Handling and Editing

Firstly, open the Workbook to start your work on a worksheet. At times, you might require inserting or deleting a worksheet, and cells to be selected.

- **Insert a Worksheet:** To insert a Worksheet between two worksheets choose Worksheet option from the Insert menu. A dialog box will appear to confirm this action.

- **Delete a Worksheet:** To remove a worksheet from the Workbook, select Delete Sheet from the Edit menu. A Dialog box will appear to confirm this action.

- **Move the Worksheet:** To move the worksheet in the same Workbook, place the mouse pointer on the sheet tab, press the left mouse button and drag it to the desired position. Release the button.

You enter all kinds of data in a cell in the worksheet. An Excel Workbook can hold any number of worksheets and each worksheet is made up of more than seventeen billion cells. Each cell carries some data and Excel treats different types of data differently. Each cell can hold any of the following three types of data:

- **A numeric value:** It can be numbers (example 300.40), dates (example 4-June-2020) or times (example 3:35 am). There are many different format options available in Excel for the display of numerical values. Numbers include digits from 0 to 9 and some special characters like $ % + - / ( ), etc.

- **Text:** Text in Excel can be used as labels for values, headings for columns or worksheets or for any kind of instructions. Text that begins with a number is still considered as text. To enter digits as text (calculations cannot be done using these kinds of entries) use an apostrophe (’) as the first character.

- **Formula:** Formulas can be entered in a cell where eventually the result of the formula is displayed. We will study more about formulas later in this unit. Example: Type TODAY () in a blank cell and press ENTER key (This function will display the system date and time)

A worksheet can also hold charts, diagrams, pictures and other objects. These objects are not contained in cells. Rather, they reside on the worksheet’s draw layer, which is an invisible layer on top of each worksheet.

In order to enter or edit data in a cell, that cell must be current. Excel indicates that a cell is current in the following ways:

- A dark black border (called the cell cursor) appears around the cell.

- The cell address appears in the Name box of the formula bar. A cell address is combination of Column Letter(s) and Row number that
interact at that cell position. For example, if the cell address is A3, it means it is at the intersection of column A and row 3.

- The cell column heading (letters) and row heading (number) is shaded for that particular cell.

![Fig. 16.15: Entering Data](image)

**Entering Data:**

For entering the data in a worksheet, you need to create a set of attributes which will be represented through a column [A, B …] in the first row. Then you can enter the specific data using that dataset. You should enter the data in a specified format for getting better results while analysing the data, otherwise they may create a problem.

There are various options available in the Home tab:

1) **[Home → Clipboard]**
   - There are options available like cut, copy, paste, format painter for making the task easier while entering a dataset.

2) **[Home → Font]**
   - There are options available like Font Face, Font Size, Font Type, Font Color, Cell Color, Borders, etc.

3) **[Home → Alignment]**
   - There are options available like Aligning the data in a cell [Left, Center, Right], Aligning the data in a merged cell [Top, Center, Bottom], Left Indent, Right Indent, Merging Cells, Wrapping Text.

4) **[Home → Number]**
   - There are options available like Currency, Percentage, General, Increasing decimal, Decreasing decimal, Date etc.

5) **[Home → Styles]**
   - There are options available like Conditional Formatting, Formatting table, Cell Styles etc.
6) [Home \rightarrow Cells] 
There are options available like 

a) Insert \rightarrow Cells, Rows, Columns, Sheets 
b) Delete \rightarrow Cells, Rows, Columns, Sheets 
c) Format 
   i) Cell Size 
      1) Row Height 
      2) AutoFit Row Height 
      3) Column Width 
      4) AutoFit Column Width 
      5) Default Width 
   ii) Visibility 
      1) Hide and Unhide 
      2) Rows 
      3) Columns 
      4) Sheets 
   iii) Organizing Sheets 
      1) Rename Sheet 
      2) Move or Copy Sheet 
      3) Tab Colors 
   iv) Protection 
      1) Protect Sheet 
      2) Lock Cell
Editing Data

You have various options available in the ribbon [Home \(\rightarrow\) Editing] for editing the dataset as per the requirement of any process.

1) Find & Select
2) Sort & Filter
3) Sum
4) Fill
5) Clear

Fig. 16.17: Sort & Filter

Sort & Filter:
1) Sort A to Z
2) Sort Z to A
3) Custom Sort
4) Filter
Find & Select:
1) Find …
2) Replace…
3) Go To
4) Go To Special
5) Formulas
6) Comments
7) Conditional Formatting
8) Constants
9) Data Validation
10) Select Objects
11) Selection Pane

Importing Data:
For the successful operation of importing data into excel you need to have a dataset in any other generic format e.g. Text.

Roll No, Name, Marks
1001, Amit, 65
1002, Arun, 68
Now, you have to follow the steps as mentioned to import the dataset into excel format.

1) Open MS-Excel
2) Click office button
3) Select the File→Open option
4) Select the Text file option from the list of file formats.

5) Choose the data file which you have placed in a location to be imported.
6) Press Open button, it will lead you towards a data import wizard → Step1
7) Choose the Delimited option and press next button. It will lead towards the next step of the wizard. Where you have to choose the delimiter (Comma, Tab, Space etc…)

8) As in our case the data is delimited using [,] thus we have chosen [Comma] option from the list of delimiters.

9) Press Next button.

10) Provide the column data format [General, Text, and Date] for every column you would like to import from an existing text file. If you don’t want to import any column than choose the same and click on “Do not import column (skip)”. 

11) Press Finish button.
Fig. 16.22: Text importing Wizard

And you will find the data in your excel spreadsheet ready for analysis or any other operation you would like to perform on it.

Fig.16.23: Data in spreadsheet

16.5.2 Formatting

There are many types of options available in MS Excel for formatting. These options are available in the Home tab. The options are as follows:

1) **Clipboard**: There are options available like cut, copy, paste, format painter for making the task easier while entering a dataset.
Fig. 16.24: Clipboard

- **Cut:** By clicking this option you can cut a selection from the document and put it on the clipboard.

- **Copy:** By clicking this option you can copy a selection from the document and paste it on the clipboard.

- **Paste:** By clicking this option you can paste the selected contents from the document on the clipboard.

- **Format Painter:** By clicking on this option you can copy the formatting from one place and apply to another.

2) **Font:** There are options available like Font Face, Font Size, Font Type, Font Color, Fill Color, Borders, Effects, Number formats and Alignment.
Spreadsheets and Business Applications

Fig. 16.25: Font

- **Font Face**: By clicking this option you can change the font face of the text that you like to change.
- **Font Size**: By clicking this option you can change the font size of the text that you require.
- **Font Type**: By clicking this option you can change the font type of the text as you want. The options are:
  
  i) **Bold**: This makes the text Bold.
  
  ii) **Italic**: This makes the text *Italic*.
  
  iii) **Underline**: This makes the text underlined. You can change the type of underline by clicking on the arrow near the icon.

- **Font Color**: By clicking this option you can change the font color of the text in the cell that you want.
- **Fill Color**: By clicking this option you can change the cell color.
- **Borders**: By clicking this option you can add the borders which you like to add.
- **Effects**: By clicking this option you can add the effects to the text like strikethrough, etc.
- **Number Formats**: By clicking this option you can change the number formats as you want like, General, Currency, etc.

3) **Alignment**: There are options available like Aligning the data in a cell [Left, Center, Right], Aligning the data in a merged cell [Top, Center, Bottom], Left Indent, Right Indent, Merging Cells, Wrapping Text and Orientation.
Fig. 16.26: Alignment

- **Aligning in a cell**: By clicking any one of the three options you can align the text in the cell as per the requirements. The options are:
  
  i) **Left Align**: Aligning text to the left.
  ii) **Center Align**: Aligning text to the center.
  iii) **Right Align**: Aligning text to the right.

- **Aligning in a merged cell**: By clicking any one of the three options you can align the text in the merged cell as per the requirements. The options are:
  
  i) **Top Align**: Aligning text to the top of the merged cell.
  ii) **Middle Align**: Aligning text to the center of the merged cell.
  iii) **Bottom Align**: Aligning text to the bottom of the merged cell.

- **Indentations**: By clicking any one of the two options you can decrease or increase the margin between the text and the cell.

- **Orientation**: It is used to rotate text or do vertical orientation and there are many types of options in it. This is often used for labeling narrow columns. There are many types of orientation that are:
  
  i) **Angle counterclockwise**
  ii) **Angle clockwise**
  iii) **Vertical Text**
iv) Rotate Text up
v) Rotate Text down
vi) Format Cell alignment

- **Wrapping Text**: It is used to visible all the contents within a cell by displaying it on multiple lines.

- **Merge Cells**: It is used to join the group of selected cells into one larger cell and centers the content in a new cell. This is often used to create labels that span multiple columns. There are options available in it that are:
  i) Merge & Center
  ii) Merge Across
  iii) Merge Cells
  iv) Unmerge Cells

4) **Number**: There are options available like Number Format, Percentage, Increasing decimal, Decreasing decimal, Accounting Number Format and Comma style.

![Fig. 16.27: Number](image-url)

- **Number Format**: It is used to choose that how the values should be displayed in a cell. As a date, percentage, currency, etc.
- **Accounting Number Format**: It is used to choose the currency format or style of your number. For example $45,000.

- **Percentage**: It is used to show the value of the number in percent format.

- **Comma style**: It is used to display the value of the cell with a thousand separators. This will change the format of the cell to Accounting without a currency symbol.

- **Increasing decimal & decreasing decimal**: It is used to increase or decrease the decimal place of the number.

5) **Styles**: There are options available like Conditional Formatting, Formatting table and Cell Styles.

   ![Spreadsheet Concepts](image)

   **Fig.16.28: Styles**

- **Conditional Formatting**: It is used to highlight interesting cells, visualize data bars, color scales and icon sets based on criteria. There are options available in it that are:
  
  i) Highlight cell rules
  
  ii) Top/Bottom rules
  
  iii) Data Bar
  
  iv) Color Scales
  
  v) Icon Sets
You also have three other options available for the rules that are:

vi) New rule

vii) Clear rule

viii) Manage Rules

Conditional formatting is one of the many other features in Excel that help us to create professional and error-free documents. Let us learn more about it.

**Conditional Formatting** allows you to quickly see differences in numbers, patterns and trends at a glance. You can highlight interesting or unusual cell values using different conditional formatting rules. To apply conditional formatting:

- Select the cells you wish to format.
- Select the Home tab and locate the Styles group.
- Click the Conditional Formatting command. A menu will appear with your formatting options. You can choose from the predefined rules or create your own new rule.
- Select one of the options to apply it to the selected cells. When you choose a predefined rule, a cascading menu will appear. And an additional dialog box may appear, depending on the option you choose. Make the necessary choices, and click OK.

*To Remove Conditional Formatting Rules:*

- Click the Conditional Formatting command.
- Select Clear Rules. A cascading menu appears.
- Choose to clear rules from the entire worksheet or the selected cells.

- **Format as Table:** It is used to quickly format a range of cells and convert it to a table by using the pre-defined label style. It has many options of colors which are differentiated by the Light, Medium and Dark type of colors. You can also create new table and pivot table styles.

- **Cell Styles:** It is used to create many types of cell styles for the selected cell. You can format the cell by choosing from the pre-defined styles. There are many options available like Data and Model, titles and Headings, etc.

- **Cells:** There are options available like:
### Fig. 16.29: Cells

- **Insert** → Cells, Rows, Columns, Sheets
- **Delete** → Cells, Rows, Columns, Sheets
- **Format**
  - **i) Cell Size**
    1. Row Height
    2. AutoFit Row Height
    3. Column Width
    4. AutoFit Column Width
    5. Default Width
  - **ii) Visibility**
    1. Hide and Unhide
      a) Rows
      b) Columns
      c) Sheets
  - **iii) Organizing Sheets**
    1. Rename Sheet
    2. Move or Copy Sheet
    3. Tab Colors
iv) Protection
   1) Protect Sheet
   2) Lock Cell

6) Editing: There are options available:

![Fig. 16.30: Editing](image)

- **Sort & Filter:** It is used to arrange the data so that it is easier to analyze. You can sort the selected in ascending or descending order or you can temporarily filter out specific values. It has options available that are:
  
  i) Sort A to Z
  ii) Sort Z to A
  iii) Custom Sort
  iv) Filter

- **Find & Select:** It is used to find and select specific data, formatting or type of information within the Workbook. You can also replace the information with new text or formatting. It has options available that are:

  i) Find …
  ii) Replace…
  iii) Go To
  iv) Go To Special
  v) Formulas
vi) Comments
vii) Conditional Formatting
viii) Constants
ix) Data Validation
x) Select Objects
xi) Selection Pane

16.5.3 Cell Comments

Comments are notes that can be inserted into any cell in Excel. Comments can be used to explain formulas, cells, and other data in the spreadsheet itself. To add a comment in the Excel worksheet:

- Select the cell where you want to add the comment.
- Click on Review tab on the Ribbon.
- Select New Comment in the Comments group.

OR

- Right click the cell to which you want to add a comment.
- Select Insert Comment from the menu. The comment box appears near the selected cell, displaying the user name.
- Type your comments in the box.
- When finished, click any other cell.

A red triangle appears on the upper right corner of the cell, indicating a comment has been attached. When you place your mouse over the cell, the comment appears.

![Student Marks Worksheet](image)

Fig. 16.31: Comment on the Total Column in Student Marks Worksheet

In our example of Students Marks in Figure 16.31, notice a small triangle on top right corner of Total column indicating there is a comment associated with it.

16.5.4 Naming Cells and Ranges

Assign a descriptive name to a cell or range in Excel to help make formulas in your worksheets much easier to understand and maintain. Range names
make it easier for you to remember the purpose of a formula, rather than using obscure cell references.

For example, the formula \(=\text{SUM(Qtr2Sales)}\) is much more intuitive than \(=\text{SUM(C5:C12)}\). In this example, you would assign the name Qtr2Sales to the range C5:C12 in the worksheet.

NAMING CELLS

To name a cell or range, follow these steps:

1) Select the cell or cell range that you want to name.
   You also can select noncontiguous cells (press Ctrl as you select each cell or range).

2) On the Formulas tab, click Define Name in the Defined Names group.
   The New Name dialog box appears.
   Use the New Name dialog box to assign a name to the selected range.

3) In the Name text box, type up to a 255-character name for the range.
   Range names are not case-sensitive; however, range names must follow these conventions:
   - The first character must be a letter, an underscore, or a backslash.
   - No spaces are allowed in a range name.
   - The range name should not be the same as a cell address. For example, you can’t name a range U2 or UB40, but BLINK182 and ABBA are just fine.

4) Click OK.

Using a Named Range

To use a named cell or range, click the down arrow in the Name box at the left end of the Formula bar. Select the range name you want to access, and Excel highlights the named cells.
You can select a range name in the Name box to quickly locate an area of a worksheet.

Fig. 16.33: Range name

You can insert range names into formulas just like they were normal cell references. Be careful while using named multi-cell ranges, though. Remember to use functions that require a range instead of a single cell reference such as MAX, SUM, or AVERAGE or else you will get an error message.

16.5.5 Addressing and Its Types

There are 16384 rows and 256 columns in one worksheet. The first cell is labeled as A1 (column as A and row number as 1) or R1C1. When a cell address is used as part of a formula, it is called a cell reference/address because instead of entering specific numbers into a formula, the cell address referring to a specific cell is being used, for example, if you have the formula =A1+B1 in cell C1, and you can use the fill handle to fill the formula into cell C3. Note that the formula won’t appear the same in C3 as it does in C1. Instead of =A1+B1, you will see =A3+B3 in cell C3. This is called Relative Reference where cell references in formulas have changed cell addresses relative to the row and column they are moved to. In relative reference, formulas automatically adjust to new locations when they are pasted into different cells. Sometimes, our requirement is such that we don’t want this change of cell address on pasting. To achieve this, cells must be addressed by Absolute Reference.

In Absolute cell references, a formula always refers to the same cell or cell range used in it. If a formula is copied to a different location, then the cell address remains the same. An absolute reference is designated in the formula by the addition of a dollar sign ($). It can precede the column reference or the row reference, or both. Examples of absolute referencing are:

$A1 – here, the column will not change when copied.
A$1 – here, the row will not change when copied.
$A$1 – here, both row and column will not change when copied.
In the above example, if we have formula as =$A$1+$B$1 in cell C1 and we copy this formula in cell C3, then you will still see =$A$1+$B$1 in cell C3.

In short the Cell references/addresses are given in different ways:

a) **Relative**: This refers to the cell relative to the given position.

   Example: Enter the following values:
   - In cell A3 enter the value 34
   - In cell A4 enter the value 23
   - In cell A5 enter the value 89
   - In cell A6 enter the formula = A3 + A4 + A5

   Copy this formula to the cell A7, and see the result.

   Observe the formula entered in cell A7. It is A4 + A5 + A6. The formula entered in cell A6 means the sum of the values given in the three cells given above the current cell. Therefore when we move down, the relation specified in the formula was copied (i.e. the three values given above the current cell which is A7 now).

b) **Absolute**: This refers to the specific cell irrespective of the position of the formula. The 'S' sign is used to denote an absolute reference.

   Example: In the cell B3 copy the formula $A$3 + $A$4 + $A$5
   
   Copy this formula to the cell B4.

   We find that the result and the formula remain the same.

c) **Mixed**: It is a combination of both relative and mixed references. It has one absolute co-ordinate and one relative co-ordinate. $D1$ and D$1$ are both examples of mixed references.

**Linking Worksheets**

Sometimes, you may want to use the value from a cell in another worksheet within the same Workbook in a formula. For example, the value of cell A1 in the current worksheet and cell A3 in the second worksheet can be added using the format "sheet name! cell address". The formula for this example would be ":=A1+Sheet3!A3" where the value of cell A1 in the current worksheet is added to the value of cell A3 in the worksheet named "Sheet3".

### 16.6 ORGANISING CHARTS AND GRAPHS

By this option you can add various types of readymade charts and graphs. It will take the data that you have entered and it will add a datasheet and add a chart as well.

After clicking on the insert tab, these options will be available in the charts option. You can select the type of chart that you want. There are many types
of charts available like Column, Pie, Line, Bar, Area, Scatter and other charts are also available in the Other Charts option. The options are:

1) **Column**: These charts are used to compare values across categories.

![Column charts](image1)

**Fig. 16.34: Column charts**

2) **Line**: These charts are used to display trends over the time.

![Line charts](image2)

**Fig. 16.35: Line charts**
3) **Pie**: These charts are used to display the contribution of each value to the total.

![Fig. 16.36: Pie charts](image)

4) **Bar**: These charts are used to compare multiple values.

![Fig. 16.37: Bar charts](image)
5) **Area**: These charts are used to compare between several sets of data over a period of time.

![Fig. 16.38: Area charts](image)

6) **Scatter**: These charts are used to compare pairs of values.

![Fig. 16.39: Scatter charts](image)
7) **Other:** In this option there are more different types of charts like:

a. Stock
b. Surface
c. Doughnut
d. Radar
e. Bubble

![Fig. 16.40: Other charts](image)

### 16.7 PROJECT INVOLVING MULTIPLE WORKSHEETS

In this section, we will learn to name, add, delete, group or ungroup worksheets. We will also learn to format a worksheet for printing.

#### 16.7.1 Naming a Worksheet

The default names of Worksheets are Sheet1, Sheet3 and Sheet3. Since these names are not useful and descriptive, we will learn to rename the worksheet.

You can rename a worksheet using any of the following ways:

- Right mouse click on the Sheet1 tab. The menu appears as shown in figure 16.41(a).
- Select option Rename. The name Sheet1 is highlighted by a black box and becomes editable.
- Type the new name at the tab.
- Press Enter. The worksheet is renamed.
Click the Format command of the Cells group in Home Tab. A menu appears as shown in Figure 16.41(b).

Select option Rename Sheet under Organize Sheet. The sheet name is highlighted by a black box and becomes editable.

Type the new name at the tab.

Press Enter. The worksheet is renamed.

16.7.2 Inserting a New Worksheet

You can add worksheets to the Workbook anytime you want. The new sheets added will be named as Sheet4 and so on. There are many ways that you can add a new worksheet:

Click on the Insert Worksheet icon near the worksheet tabs OR press Shift+F11.

A new worksheet after the last tab will be added.
Right mouse click on the worksheet tab.

Choose Insert… from the menu (shown in Figure 16.41(a)). Insert dialog box opens.

Select Worksheet. Click Ok

A new worksheet before the selected tab will be added.

OR

Click the down arrow of Insert command in the Cells group of Home Tab. A menu appears.

Choose Insert Sheet from the menu.

A new worksheet before the selected worksheet will be added.

16.7.3 Deleting a Worksheet

Any number of worksheets can be deleted irrespective of the fact that they contain any data or not. But, there should be at least one worksheet in the Workbook. To delete a worksheet:

- Right mouse click on the worksheet tab.
- Choose Delete from the menu (shown in Figure 16.41(a)).
- The selected worksheet is deleted.

OR

- Click the down arrow of Delete command in the Cells group of Home Tab. A menu appears.
- Choose Delete Sheet from the menu.
- The selected worksheet is deleted.

16.7.4 Grouping Worksheets

If the multiple worksheets of a Workbook contain identical formula and formatting, then you can group them together. When the worksheets are grouped together, then any change made to one worksheet will be applied to all other worksheets in the group. You can group both contiguous and noncontiguous worksheets. To group contiguous worksheets:

- Click on the first worksheet tab.
- Press the Shift key.
- While holding the Shift key, click the last worksheet tab you want in the group.
- Release the Shift key.
- All the sheets from the first sheet to the last sheet are now grouped. The tab color will now change to white indicating that they are grouped together.
To group noncontiguous worksheets:
- Click on the first worksheet tab.
- Press the Ctrl key.
- While holding the Ctrl key, select all the other worksheets you want in the group.
- Release the Ctrl key.
- All the sheets that you selected while keeping the Ctrl key pressed would be grouped together and sheet tabs will appear white.

16.7.5 Ungrouping Worksheets

To ungroup worksheets:
- Right mouse click one of the worksheets in the group.
- Select Ungroup Sheets from the menu.

16.7.6 Repositioning Worksheets in a Workbook

To change the position of worksheets in a Workbook:
- Click and hold the worksheet tab that is to be moved until an arrow appears on the left corner of the sheet.
- Drag the worksheet to the desired location

16.7.7 Hiding Worksheets

To hide a worksheet:
- Right-click on the tab of the sheet you wish to hide.
- Select Hide
  OR
- Click the Format button.
- Select Hide & Unhide under Visibility on the menu.
- Choose Hide Sheet option.

To unhide a worksheet:
- Right-click on tab of any sheet.
- Select Unhide…. A dialog box with the list of hidden worksheets is displayed.
- Choose the sheet to unhide.
  OR
- Click Format button.
Select Hide & Unhide under Visibility on the menu.

Choose Unhide Sheet… option. A dialog box with the list of hidden worksheets is displayed.

Choose the sheet to unhide.

### 16.7.8 Linking Worksheets

Sometimes, you may want to use the value from a cell in another worksheet within the same Workbook in a formula. For example, the value of cell A1 in the current worksheet and cell A3 in the second worksheet can be added using the format "sheet name! cell address". The formula for this example would be "=A1+Sheet3!A3" where the value of cell A1 in the current worksheet is added to the value of cell A3 in the worksheet named "Sheet3".

For with protecting your to you Workbook you need access to the credentials via Information Rights Management, which assigns a valid code for identification.

### 16.7.9 Protecting the Workbook

It provides you worthy credentials after a service signup. IRM uses a server to authenticate the credentials of people who create or receive documents or e-mail with restricted permission.
Fig. 16.43: Service Sign-up

You can protect your worksheet using following options available in excel.

Fig. 16.44: Protect Sheet
You can protect various components of the worksheet individually:

![Protect Sheet dialog box](image)

For the protection purpose you need to mention a password, which will be required if you would like to unprotect or unlock the worksheet.

### 16.7.10 Saving a Worksheet

You can also save the worksheet for various purposes like:

1. Open a Workbook
2. Editing a Workbook

It could be done at the time of saving the Workbook. You can opt for “General options” through the Tools button available near Save Button.

![Tools option in Save As](image)
You can provide password to open or a password to modify. The point to remember is you have to click the Read-only recommended.

![Fig. 16.47: Creating password](image)

### 16.8 PRINTING A WORKSHEET

Once you are finished with your work in a Workbook, you would like to have some prints of your worksheet, for which you have to follow the given instructions:

- Click Office button
- Select Print option
- Choose the option out of given list
  - Print
  - Quick Print
  - Print Preview

![Fig. 16.48: Print Menu](image)
1) **Print:** This option will open a dialog box through which you can customize your printout.

![Print Option](image1.png)

**Fig. 16.49: Print Option**

2) **Quick Print:** This option follows the default setting for your printer and directly forwards the worksheet for printing purpose.

3) **Print Preview:** This option shows a print preview screen as shown in figure below which provides various options through which you can customize your print without wasting printouts (hard copies) of the actual document/ worksheet.

![Print Preview](image2.png)

**Fig. 16.50: Print Preview**

After having a print preview of the worksheet we can look forward to page setup before taking the printout. It gives further options for setting following dimensions of a printout:

- **Page**
- **Margins**
Now, the Page option has got sub-options for page setup:

1) **Page Orientation**
   a) Portrait [e.g. 8.5” x 11” for letter]
   b) Landscape [e.g. 11” x 8.5” for letter]

2) **Scaling**
   a) Adjust: You can adjust [Enlarge/ Reduce] the content size from 100% scale.
   b) Fit to: You can choose that how many pages are needed to occupy the content of your worksheet.

3) **Paper Size**: You can choose the paper size from the drop-down list.

4) **Print Quality**: You can choose the print quality
   a) Standard
   b) Text/ Line
   c) Web quality

![Page Setup](image)

**Fig. 16.51: Page Setup**

Next option is assigned by the next tab – Margins. It offers various options to set for the margin purpose.

1) **Top / Bottom**: By default [0.75]
2) **Left / Right**: By default [0.7]
3) **Header / Footer**: By default [0.3]

You can also center your printout by either / both [Horizontally/ Vertically].
16.9 HOW TO USE EXCEL HELP

How to Get Help in Excel

1) Click the Excel Help button or press F1. ...

2) Click the Help links until you find the topic you want. ...

3) Click the Show Table of Contents button. ...

4) Type keywords in the Search box and click the Search button. ...

5) Right-click the Windows taskbar and select Show Windows Side by Side.

The Help button (circle with a question mark inside) is located above and to the right of the Ribbon

Once selected a new Excel Help window appears

- Help Categories:
  - Select any Topic under Browse Excel Help to find more helpful Subtopics

- Help Search
  - Click inside the textbox, type a topic, and click Search

- You can also navigate and find other helpful options (like Home and Print) on the toolbar located near the top of the Help window
Click on the button shaped like a closed book to view the Table of Contents

A large number of help documents are located on your computer. However, greater detail and more topics are available if the computer is connected to the internet.

Check Your Progress B

1) What is a cell address?

2) What are cell comments?

3) Name the cell referencing in which both row and column will not change when copied.

4) Which charts are used to display the contribution of each value to the total?

16.10 LET US SUM UP

Spreadsheets are brilliantly conceived ways to organize data by grouping it into rows and columns, they are used to organize, analyze and manipulate all type of data but it provides enhanced functionalities for numerical data.
Microsoft Excel comes bundled in Microsoft Office which is an office automation tool. It is one of the powerful spreadsheet tools, which is used by different people in their day-to-day jobs.

Excel screen layout is the screen that appears when we open the Microsoft Excel. It has different components such as the ribbon, the quick access toolbar, the title bar. And each component has its own significance. For instance the quick access toolbar provides you access to the commands you frequently use or the title bar displays the title of the Workbook on which you are currently working.

16.11 KEY WORDS

The Title Bar: It displays the title of the Workbook on which you are currently working. By default, the first new Workbook is named as Book1.

The Menu Bar: The menu Bar is the panel at the top portion of the document, right below the Title Bar. To begin with, it has the following seven tabs such as Home, Insert, Page Layout, Data, etc.

The Worksheet Area: The worksheet area displays all the cells. It is in the cells that you enter, format or edit your data.

The Status Bar: The Status bar appears at the very bottom of the Excel window and provides such information as the sum, average, minimum, and maximum value of selected numbers.

Cell address: It is a combination of Column Letter(s) and row number that intersect at that cell position. For example, if the cell address is A3, it means it is at the intersection of column A and row 3.

Conditional Formatting: It is used to highlight interesting cells, visualize data bars, colour scales and icon sets based on criteria. There are various options available in it such as Highlight cell rules, Top/Bottom rules, Data Bar, Colour Scales, etc. It helps us to create professional and error-free documents.

Cell Comments: Comments are notes that can be inserted into any cell in Excel. They are used to explain formulas, cells, and other data in the spreadsheet itself.

16.12 TERMINAL QUESTIONS

1) Explain the various components of excel screen.
2) Explain the different tabs available on Menu Bar.
3) What are the three sections of the Formula Bar?
4) What are the different types of data that cells can hold?
5) What are the various options available in the Home tab?
6) What is Conditional Formatting?
7) What do you mean by Cell referencing?
8) Explain the three types of cell referencing with examples.
9) What is the difference between Print and Print Preview?

Note: These questions are helpful to understand this unit. Do efforts for writing the answer of these questions but do not send your answer to university. It is only for yours practice.